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About Toad for Oracle

Toad for Oracle provides an intuitive and efficient way for database professionals of all skill and experience levels
to perform their jobs with an overall improvement in workflow effectiveness and productivity. With Toad for Oracle
you can:

« Understand your database environment through visual representations

+ Meet deadlines easily through automation and smooth workflows

« Perform essential development and administration tasks from a single tool

« Deploy high-quality applications that meet user requirements; perform predictably and reliably in production
» Validate database code to ensure the best-possible performance and adherence to best-practice standards

» Manage and share projects, templates, scripts, and more with ease

The Toad for Oracle solutions are built for you, by you. Nearly two decades of development and feedback from
various communities like Toad World have made it the most powerful and functional tool available. With an installed-
base of over two million, Toad for Oracle continues to be the "de facto" standard tool for database development and
administration.

Toad for Oracle resources

Toad World is a unique and valuable resource available to all Toad users. Toad World provides forums, blogs,
videos, product information, Beta releases (when available), and Trial downloads for Toad products. Visit Toad
World at: https://www.toadworld.com.

Two of the most-often used features of Toad World are the Forums and the Idea Pond.

« On the Idea Pond page, you can submit your ideas to improve Toad and vote for or comment on other
ideas. The Toad team takes your suggestions seriously, and you may even hear back from one of our
developers on the topic. We encourage all Toad users—from new to experienced—to let us know how we
can improve Toad.

+ On the Forum page, you can ask a question or start a discussion and view all other forums within the
Toad community.

The Toad World blog pages feature a broad range of information, including topics of interest to our industry, as well
as instructions from team members on how to use the latest Toad features.

The Toad for Oracle web-based training is a perfect accompaniment to your product license. This free training walks
you through major product features and explains how to perform frequent tasks. You’ll also see how to utilize time-
saving automation functionality. You'll receive a certificate of completion for each course once you pass the
accompanying test.

About this release

Toad for Oracle2024 R2 is a minor release, with enhanced features and functionality.

Toad for Oracle 2024 R2 includes component and requirement upgrades. These upgrades address security
vulnerabilities previously identified in the third party component.
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About Toad® for Oracle®Editions

Each Toad for Oracle Edition is packaged with additional Quest products to expand your experience.

Toad for Oracle Subscription

Toad for Oracle is now available with subscription licensing. The benefits of subscription include:

« All of the great, award-winning Toad features you have grown to love
» Access to our world-class support team, Knowledge Base, how-to videos and more
» Quest Auto Update keeping you on the latest version

e Online License Management making it easy to assign licenses to individuals, keep track of individual
usage, manage organizations, and reassign unused or under-used licenses as needed to ensure
license compliance

« Automatic Renewal ensuring that Toad for Oracle Subscription will be continuously available to users

« Invitations to training events like our Ask Toad and Toad Training Tuesdays series

The following products may be part of your Toad for Oracle Subscription Edition:
e Toad for Oracle
« Benchmark Factory for Databases
» Code Tester for Oracle
* Spotlight on Oracle
* SQL Optimizer for Oracle
« erwin Data Modeler Lite for Oracle

e Toad Data Modeler

NOTE: All Subscription Editions are available in an 'Al Enabled' version, which includes everything in the standard
edition plus the AlExplain feature to assist with code comprehension. Read more about AlExplain at Toad World.

The following Toad for Oracle Subscription Editions are available:

Edition Licensed

Toad for Oracle Base Subscription Toad® for Oracle®
Edition

Toad for Oracle Professional Toad® for Oracle® Professional
Subscription Edition

Toad for Oracle Professional DB Everything in Toad® for Oracle® Professional
Admin Subscription Edition )
DB Admin Module Add-on

Sensitive Data Protection Add-on

Toad for Oracle 2024 R2
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Edition

Licensed

Toad for Oracle Xpert Plus Edition

Toad for Oracle Developer Plus
Edition

Toad for Oracle DBA Plus with
erwin Edition

Toad for Oracle DBA RAC Plus
with erwin Edition

Toad for Oracle DBA Exadata
Plus with erwin Edition

Toad for Oracle DBA Plus

Toad for Oracle DBA RAC Plus

Toad for Oracle DBA Exadata
Plus

Everything in Toad® for Oracle® Professional DB Admin Edition
SQL Optimizer for Oracle®

Everything in Toad® for Oracle® Xpert Plus
Code Tester for Oracle®

Benchmark Factory® for Databases - Oracle Edition with 100 virtual users

Everything in Toad® for Oracle® Developer Plus
Benchmark Factory® for Databases - Oracle Edition with 500 virtual users
Spotlight on Oracle®

erwin Data Modeler Lite for Oracle®

Everything in Toad® for Oracle® DBA Plus with erwin
Spotlight on Oracle® with RAC Option

Everything in Toad® for Oracle® DBA RAC Plus with erwin — Includes
Exadata

Spotlight on Oracle® with RAC and Exadata Options

Everything in Toad® for Oracle® Developer Plus

Benchmark Factory® for Databases - Oracle Edition with 500 virtual users
Spotlight on Oracle®

Toad Data Modeler®

Everything in Toad® for Oracle® DBA Plus
Spotlight on Oracle® with RAC Option

Everything in Toad® for Oracle® DBA RAC Plus — Includes Exadata
Spotlight on Oracle® with RAC and Exadata Options

NOTE: Spotlight on Oracle® includes Spotlight on Unix/Linux, Spotlight on Windows, and Spotlight on Oracle®

Data Guard.

Toad for Oracle non-Subscription

Toad for Oracle non-Subscription uses offline term and perpetual licensing. This is Toad for Oracle's legacy

licensing model.

The following products may be part of your Toad for Oracle non-Subscription Edition:

e Toad for Oracle

o Benchmark Factory for Databases

e Code Tester for Oracle

» Spotlight on Oracle

Toad for Oracle 2024 R2
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« SQL Optimizer for Oracle
« erwin Data Modeler Lite for Oracle

e Toad Data Modeler

The following Toad for Oracle non-Subscription Editions are available:

Edition Licensed

Toad for Oracle Base Edition Toad® for Oracle®

Toad for Oracle Professional Toad® for Oracle® Professional

Edition

Toad for Oracle Xpert Edition Everything in Toad® for Oracle® Professional
SQL Optimizer for Oracle®

Toad for Oracle Developer Edition  Everything in Toad® for Oracle® Xpert
Code Tester for Oracle®

Benchmark Factory® for Databases - Oracle Edition

Toad for Oracle DBA with erwin Everything in Toad® for Oracle® Developer
Edition DB Admin Module Add-on
Spotlight on Oracle®
Benchmark Factory® for Databases - Oracle Edition

erwin Data Modeler Lite for Oracle®

Toad for Oracle DBA RAC with Everything in Toad® for Oracle® DBA with erwin

erwin Edition Spotlight on Oracle® with RAC Option

Toad for Oracle DBA Exadata with  Everything in Toad® for Oracle® DBA RAC with erwin — Includes Exadata
erwin Edition Spotlight on Oracle® with RAC and Exadata Options

Toad for Oracle DBA Edition Everything in Toad® for Oracle® Developer

DB Admin Module Add-on

Spotlight on Oracle®

Benchmark Factory® for Databases - Oracle Edition
Toad Data Modeler®

Toad for Oracle DBA RAC Edition  Everything in Toad® for Oracle® DBA
Spotlight on Oracle® with RAC Option

Toad for Oracle DBA Exadata Everything in Toad® for Oracle® DBA RAC — Includes Exadata
Edition Spotlight on Oracle® with RAC and Exadata Options

NOTE: The DB Admin Module can be added to any Toad Edition. Spotlight on Oracle® includes Spotlight on
Unix/Linux, Spotlight on Windows, and Spotlight on Oracle® Data Guard.
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Toad for Oracle on Mac

Toad for Oracle is now available for Mac using a new license specific for macOS. Click here to download
the free trial.

It includes the great, award-winning Toad features you have grown to love with a few limitations:

There is no installer so setting Toad to be read-only or disable internet access using command-line
arguments during installation is not possible

Scheduling tasks and Utilities | Task Scheduler are unavailable

Auto Update is unavailable in the Subscription version

The edition includes Toad for Oracle; additional Quest products are not included

Team Coding does not support VCS integration

Excel Instance and Microsoft Access formats for Export/Import features are unsupported

Only executables bundled with Toad may be launched (e.g. Toad Script Runner); other external applications
and Utilities | External Tools are unsupported

Font choosers may appear to duplicate fonts due to truncation; Courier New, Courier New Baltic, and
Courier New Greek, for example, may all show as Courier New

Only clientless connections are supported
« Direct connect works as usual

o TNS and LDAP connections work as usual provided the network configuration files (e.g.
tnsnames.ora, Idap.ora, and sqlnet.ora) are found on disk in either of these folders:

« $TNS_ADMIN
« $ORACLE_HOME/network/admin

o IfTNS_ADMIN and ORACLE_HOME are not defined environment variables you may place the
network configuration files in a special folder created by Toad upon first launch for this purpose; only
one of these folders will exist depending on your version of Toad:

« ~[Library/Application Support/Toad for Oracle/TnsAdmin
o ~[Library/Application Support/Toad for Oracle Subscription/TnsAdmin

The following Toad for Oracle on Mac Editions are available:

Edition Licensed
Toad for Oracle on Mac Toad® for Oracle® Professional
Professional DB Admin DB Admin Module Add-on

Subscription Edition

Sensitive Data Protection Add-on

Toad for Oracle on Mac Toad® for Oracle® Professional
Professional DB Admin Edition DB Admin Module Add-on
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Install

1. Download the Toad for Oracle on Mac zip file
2. Double-click the zip file; macOS will automatically extract it to the current folder

3. Optionally copy the app folder to the Applications folder; macOS will prompt you to do so upon first run if
run from any other location

Uninstall

1. Quit Toad for Oracle
2. Move the app folder to Trash

3. Removing the app does not remove Toad for Oracle's configuration files; delete ~/Library/Application
Support/Toad for Oracle for complete removal

For more information about the products in your Toad for Oracle Edition and the minimum system requirements
for running these products, see the Toad for Oracle Editions release notes at:
https://support.quest.com/technical-documents

Toad for Oracle 2024 R2
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New Features and Enhancements

Toad for Oracle 2024 R2

Product Version

Toad for Oracle now uses a product version corresponding to the year of release, e.g 2024 R2 for the second
release in 2024.

Toad for Oracle Subscription Editions

All Subscription Editions are available in an 'Al Enabled' version, which includes everything in the standard edition
plus the AlExplain feature to assist with code comprehension. Read more about AlExplain at Toad World.

Oracle 23ai Support

SQL Firewall (Database menu | Administer | SQL Firewall) Note: Requires DB Admin module
Tablespace Shrink

Logical Partition Tracking

Open pluggable databases in hybrid read-only mode

Hybrid partitioned tables with interval and auto list partitioning
Rename LOBs without moving them

Concurrent refreshes in materialized views

Read-only users

Enable/disable dictionary protection

Individual columns in Unified Audit Policies

VECTOR datatypes

VECTOR indexes

Staging tables

Create Tablespace window defaults to 'bigfile’

Toad for Oracle 2024 R2
Release Notes


https://blog.toadworld.com/toad-for-oracle-introducing-the-beta-ai-explain-feature

Accessibility

Improved keyboard navigation in Toad Options.
Data Grid context menu activates with F10.
Editor caret width is configurable (Toad Options | Editor | Display).

Editor shortcut to toggle focus between dock panel and edit area (F6) is now customizable (Toad Options |
Toolbars/Menus | Shortcuts).

A new 'Focus Toolbars' feature has been added to the Window menu, enabling you to highlight and interact
with a specific toolbar. You can navigate through toolbar buttons using the TAB key and activate them with
ENTER. This feature can also be accessed via the customizable shortcut Ctri+" (Toad Options |
Toolbars/Menus | Shortcuts).

A 'Docked Panels' feature has been added to the Window menu, allowing you to highlight a specific
docked panel.

Improved keyboard navigation in the 'Add Multiple Logins' and 'Edit Login' windows available from the
database login window.

Schema Browser

The roles filter now includes an option to exclude roles managed by Oracle.

The 'Drop Index' confirmation dialog includes an option to drop any constraints that would otherwise prevent
the index from being dropped, avoiding the ORA-02429 error. If selected, both the constraint and the index
will be dropped.

Custom queries and filters can be saved globally for a specific table name (Toad Options | Schema
Browser | Data).

The 'Data’ tab filter utilizes the date format set in the options (Toad Options | Data Grids | Data).
The base and log tables for Materialized View Logs are displayed on the 'Info’ tab.
Introduced the option to enable or disable Unified Audit Policies.

Introduced icons to indicate whether Unified Audit Policies are enabled.

Editor

Advanced options have been added to control editor rendering, enhancing appearance on high-DPI displays
(Toad Options | Editor | Behavior).

Shift + Right-clicking on a database object name displays the Schema Browser context menu.

An option has been added to collapse all regions at any level when using 'Fold All' (Toad Options | Editor
| Behavior).

Single Record View displays the table name.

Toad for Oracle 2024 R2
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Connections

« An option has been added to disconnect after a specified period of inactivity (Toad Options | Oracle |
Connections).

« A connection timeout option has been added to abandon slow connection attempts (Toad Options | Oracle
| Connections). Applies to clientless connections only.

Data Grids

« Improved appearance on high-DPI displays.

» Rearranged the context menu to make the most frequently used feature easier to access.

Describe Window

e Introduced a refresh button.

SGA Trace/Optimization

« Renamed to 'Shared Pool Browser.'

« Individual statements can be purged from the shared pool.

Connection Colors

» Introduced a 'Suggest' feature to recommend a color based on user-defined rules.

Session Browser

« Introduced 'Styles' to the context menu of the 'Sessions' tab grid.

Font Dialog

« The font chooser dialog can be filtered and will retain your recent selections.

Create Constraint

« Awarning is displayed if you are about to create a circular foreign key constraint.

Toad for Oracle 2024 R2
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Automation Designer

« Enhanced the placement of actions when double-clicking in the palette.

Code Insight

« An option has been added to filter by 'Contains text' or 'Starts with text' (Toad Options | Editor |
Code Assist).

DB Health Scan

« Informational and statistical items no longer contribute to the pass/fail status.

o Failures are now reported as the count of failed checks instead of the total number of failures.

Compare Schemas

« 'ALTER TYPE'is utilized, when feasible, to synchronize types and prevent errors associated with 'CREATE
OR REPLACE TYPE' when dependencies are present.

Compare Databases

¢ Introduced a preview panel.

Manage User Settings

« Introduced the ability to restore individual settings from backup.

Workspaces

» Introduced a 'Cancel’ button to halt workspace loading.

Master-Detail Browser

o Added "Current Schema" option to make configuration files portable across different schemas with the
same tables.

Project Manager

« Afilter has been added to refine nodes.

Toad for Oracle 2024 R2
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Explain Plan

« Additional 'Copy to Clipboard' actions have been added to copy content as an image or XML.

Team Coding

« Introduced a 'Locked By’ field in both the Schema Browser and the Editor.

» Introduced an option to designate either the operating system username or the database login username as
the lock user.

utPLSQL

« Introduced support for utPLSQL 3.14.

Toad for Oracle 17.1

AlExplain

Using the power of Al, Toad examines your code providing an explanation of its purpose.

Note: AlExplain is available to Toad for Oracle Subscription users. Refer to the Knowledge Base for instructions on
how to enable it. Learn more about Al and Toad at Toad World.

Toad for Oracle on Mac

¢ Improved Editor and Data Grid fonts
e Toad's File menu is merged into the macOS File menu

e The TNS_ADMIN location is more prominent

IPv6

IPv6 support has been extended to the following features:
« Clientless database connections
« SSH
o SIFTP
+ RExec

Toad for Oracle 2024 R2
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Connections

More prominent connection color border on Connection and Window toolbar buttons

Menu items added to the "Session" menu allow for disconnecting sessions without closing associated
windows

« "Disconnect" and "Disconnect all" will leave the connection toolbar button intact as well as all
associated windows, but the underlying session to the database will be terminated

« "End Connection" in previously releases has been renamed "Close Connection" and functions
the same as it always has; the underlying Oracle session is terminated and all associated
windows are closed

Audit and Access banner text is displayed for clientless connections

Option to allow/prevent access to the SYS.USERS table, allowed by default (View | Toad Options | Oracle
| General | "Check for access to SYS.USER$")

Option to include/exclude "as SYSDBA" in Connection toolbar button caption, shown by default (View |
Toad Options | Toolbars/Menus | Toolbars | "Include ‘as SYSDBA™)

Automation Designer

Actions and apps can be disabled to prevent them from running
Action properties can be modified in bulk
Generate Schema Script action supports variables in the "Top Level Directory" field

Generate Schema/Database Script and Compare Schema/Database actions support variables for
connections and source/target schemas

Export Dataset action now executes all statements in a script and exports the results of SELECT statements
Execute Script action will automatically check ORA error codes added to the list of ignored errors

Execute Script action property to "Notify on script error" suppresses all errors when unchecked,
shown by default

Email action supports content type (Plain Text or HTML)

Improved saving of the underlying data file to better support multiple, concurrent running Toad instances

Schema Browser

Quick filters can be saved per connection

Ctrl+F in the left side places focus in the "Quick Filter" edit
Commit/Rollback buttons enable only when in transaction
Tablespace "Free Space" tab displays storage used by recycle bin
"Create insert statements for all rows" supports "Data Masking"

Tablespaces "Objects" tab now has a button to rebuild selected objects allowing you to move them to a
new tablespace

Toad for Oracle 2024 R2
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Tablespaces "Add > Datafile" now works across multiple selected tablespaces
Tables "Indexes" tab has "Created"

Tables "Stats/Size" tab has "Include indexes" checkbox

Favorites persists node expansion state

Some commands have configurable shortcuts (View | Toad Options | Toolbars/Menus | Shortcuts)

Compare Schemas

e Comparison includes EDITIONABLE

Data Grids

Blob preview for PDF, XLSX, DOCX (first page), Text, Image, and Hex

Customizable context menu

Trace File Browser

Advice for more wait events

"Wait Summary" histogram

The worst performing SQL is highlighted in red

SQL binds driven by a CURSOR loop are automatically identified

"File Header" tab added to better organize data previously shown on the "Query Summary" tab
"Wait Summary" tab includes min/avg column

Notes can be added to a SQL statement

"File Preview" includes start/end times, executions, fetches, and parses

Create/Alter Schedule/Scheduler Job

Buttons for sample start and end times

Script Execution

e Summary grid summarizes the execution/fetch/total times, number of rows, and the SQL of the

other data grids

Debugger

Breakpoints persist between debugging sessions

Toad for Oracle 2024 R2
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Workspaces

« Auto Save and Load options are separate

Create Unified Audit Policy

o Added support for CONTAINER=ALL when connected to a root CDB

Toad Script Runner

« Use F2 to toggle full screen edit area
e Connection info shown in title bar matches Toad

« |mproved tab navigation with a dropdown arrow to list all tabs

Session Browser

» Start and stop tracing across all database sessions

« Active filter name is displayed in the toolbar

Login Window

» Option checkboxes have been moved to the Settings dropdown menu, e.g. Save Passwords
« TNSPING button returns the output of thsping.exe verbatim
« Focus is restored to the grid column that was focused when the window was last closed

« Option added to place focus in the grid or right side when opened

Spool SQL

¢ OCI Describe events are shown

Toolbars

o Close a connection/window by middle clicking on its toolbar button

Create/Alter Datafile

« Add multiple datafiles at once

« Find/Copy now lists the default disk group (ASM)

Toad for Oracle 2024 R2
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Tablespace Map

« Display the contents of a single datafile in multi-file tablespaces

Export DDL

o Much faster when exporting multiple objects

Note: The order of statements and number of line breaks may differ when using "One file per schema" or
"One file per object type" options

Team Coding

« Improved performance working with multiple objects, e.g. check in/out

Workspaces

« "Save" saves without confirmation
e "Save as" added

« "Delete" and "Rename" options show additional info about the workspace

Toad for Oracle 17.0

Toad for Oracle on Mac

Toad for Oracle Professional DB Admin edition is now available for Mac. Click here to download the free trial.

Oracle 23c

« Support for new features in Create/Alter windows, generated scripts, and elsewhere as appropriate:
« ANNOTATIONS
» Boolean datatypes
o DEFAULT ON NULL FOR INSERT AND UPDATE
« DOMAINS
« |IF[NOT]EXISTS
« JSON-Relational Duality Views
« PRECHECK Constraints

« Schema-level privileges

Toad for Oracle 2024 R2
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Editor

» Data grids can be pinned allowing for multiple statements to be executed within a single tab without losing
the results of the previous execution

« Option added to trim whitespace when saving files

« Improved performance when the Navigator option to "Show references" is unchecked; also applies to the
Schema Browser when viewing PL/SQL objects

o Improved performance of parameter assistance for Oracle built-in functions defined within the
SYS.STANDARD package, e.g. TO_CHAR()

« Added an option to the Script Output tab that synchronizes the Editor caret position with the active Script
Output data grid and vice versa

« Exporting all Script Output data grids to an Excel file now produces a summary sheet
« 0Old, automatic backups are purged for improved performance

« Option added to enable utPLSQL integration if it is installed; unchecking this option improves performance
by eliminating internal queries, but disables all Editor support for utPLSQL test suites

Connections

e SSH connections can be made natively without needing PUTTY or similar
o Clientless connections support TCPS protocol

« Common users having the SET CONTAINER privilege can easily switch between CDB and PDB instances
via the Connection Bar context menu

Connection Colors

« An option has been added to fill Toad's title bar with the active connection's color when using a color scheme
and connection colors

Trace File Browser

» Improved workflow when loading files from the database server
e Option to exclude non-SQL trace files
« Filter by file content, e.g. SQL ID, tablename, or any text that may exist in the trace file
« Limit files to only those produced within a specified timeframe

« Option to preview files after retrieval

Toad for Oracle 2024 R2
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Object Palette

« Option added to "Show Subobjects" that displays related objects (e.g. table constraints, grants, indexes,
triggers, etc.) just like the Schema Browser's "Show LHS Subobjects" feature

Automation Designer

« Improved Action palette

» Export Dataset action can pass variables to SQL files as parameters

Data Grids

« Columns can be sorted even when the query contains an ORDER BY clause
o Find Data and Filter Data from the context menu allows searching and filtering across multiple columns
« Arefresh button has been added to the Editor Data Grid to reexecute the query

» Single Record Viewer supports copying the column header and value to clipboard

Compare Schemas

« Options added to verify that tablespaces and Oracle features exists in the target database; any violations
that will cause the sync script to fail are identified in the Difference Details tab

Generate Schema Script

» Added the ability to combine related objects when generating one script per object; for example, synonyms
and grants with their target objects, type/package with its body, indexes with their table, etc.

» An option has been added to include schema name in object filenames

« An option has been added to include private synonyms for objects when exporting

Schema Browser

« Improved performance when selecting Procedures, Functions, and Packages

» Added the ability to pin quick filters

Session Browser

« "Kill Session" button added to the Locks tab

o "Status" column added to the Locks tab

Toad for Oracle 2024 R2
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Import Table Data

» Added the ability to create a new table from the Import Table Data wizard prior to importing

Workspaces

« New command line parameter for launching Toad and opening a specific workspace, e.g. Toad.exe -
workspace my favorite workspace name

Debugger

« Anew "Check Privileges" menu item is available from the main Debug menu to check the active connection
for the privileges required to debug

DB Health Scan (Preview)

DB Health Scan is a new window similar to DB Health Check with improved visualization of results. This window is a
preview feature with additional improvements planned for a future release.

SQL*Net Editor

o Added support for SSL parameters

TNSNames Editor

» Added support for Retry Delay, Retry Count, and Compression parameters

You can find the most up-to-date list of new features for this release in the Toad for Oracle Release Notes found at:
https://support.quest.com/toad-for-oracle/technical-documents.
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Discontinued Features

Knowledge Xpert. Knowledge Xpert is no longer available on Toad World. Beginning with release 13.1, Toad
components no longer reference the online Knowledge Xpert.

Ask a Question. The Go to Toad World and Ask a Question commands on the Toad World toolbar have been
replaced. To ask a question, click the Forums toolbar button to go directly to the forum. To go to Toad World, click
the Forums or the Browse Blogs toolbar buttons. You can also use the Help menu: Help | Toad World | Forums.
This change is found in Toad for Oracle 13.1 or later.

Integration with Toad Intelligence Central. Beginning with Toad for Oracle 13.1, Toad no longer provides
integration with Toad Intelligence Central. The Toad Intelligence Central window is not available and you cannot
publish scripts, files, Code Analysis results, and other resources to a Toad Intelligence Central server using Toad for
Oracle. You cannot connect to Toad Intelligence Central through Toad for Oracle.
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Resolved issues

The following is a list of issues addressed and enhancements implemented in this release of Toad for Oracle.

Toad for Oracle 2024 R2

The following list of resolved issues includes issues received from the Toad for Oracle forum, Toad Beta users, and
exception data collected from the Toad Improvement Program.

Issue ID Link to Resolved Issue
Forum Post

TOR-5153 link Editor: Wrong desktop is assigned after reordering tabs.

TOR-6187 link Code Insight: Join conditions based on referential integrity are not shown.

TOR-6446 link Editor: 'Load object at caret' does not respect the option to load package/type
spec and body as a pair.

TOR-7853 link Connections: "Net: Invalid input arguments" error upon connecting to some
databases in clientless mode.

TOR-8187 Debugger: Stepping into Java Source throws an error.

TOR-8188 Extract DDL: Table scripts exclude the object_table_substitution clause.

TOR-8194 Schema Browser: Create user script excludes private synonyms if the script is
generated for multiple, selected users.

TOR-8196 link Compare Schemas: REVOKE ROLE command appears before its comment in
the sync script.

TOR-8205 Session Browser: Refreshing the page results in a brief flicker before the data
fully loads.

TOR-8206 Schema Browser: ORA-01009 error is raised when selecting the SYSTEM
tablespace.

TOR-8216 link Add Login Record: TNS dropdown only populates when TNS_ADMIN
environment variable is defined.

TOR-8232 Schema Browser: Script tab for object table excludes NOT NULL constraints.

TOR-8233 link

Editor: EDIT command generates a read-only grid when the "OCI Array Buffer
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https://forums.toadworld.com/t/option-problem-desktop-sql-o-plsql/51382
https://forums.toadworld.com/t/consider-constraints-when-suggesting-join-conditions/55277
https://forums.toadworld.com/t/editor-load-at-caret-only-loads-package-body/52597
https://forums.toadworld.com/t/net-invalid-input-arguments-when-connecting-to-oracle-23c/58740
https://forums.toadworld.com/t/toad-17-sync-script-alignment-question/59407
https://forums.toadworld.com/t/tns-database-drop-down-is-not-populated-when-creating-new-login/59476
https://forums.toadworld.com/t/edit-command-doesnt-work-grid-is-read-only/59485

Issue ID Link to Resolved Issue
Forum Post
Size" option is set to "Manual”.

TOR-8245 link Editor: Inline parameter assistance cancels and leaves artifacts when clicking
elsewhere in the Editor while the assistance is showing.

TOR-8247 link Automation Designer: Export Dataset action shows "Parameters are out of
sync" message in some cases.

TOR-8299 Command Line: Running Toad.exe with the "-c" option to make a connection
does not work if Toad is running and the "Allow multiple copies of Toad" option
is unchecked.

TOR-8303 link Editor: Filename paths shown as tab hints stop working in some cases.

TOR-8305 Object Compare: The sync script tab is missing when comparing objects with
identical schema and object names across two connections.

TOR-8314 Connections: An access violation occurs when connecting to a schema having
an expired password if no Oracle clients are installed.

TOR-8330 link Editor: Character and caret misplacement when using Windows scaling other
than 100% with some font and size combinations, e.g. Consolas 14 pt and
others.

TOR-8331 Team Coding: Getting the latest revision fails if the character case of the file
extension differs between the local and remote files.

TOR-8334 Database Browser: A "Password not supplied" error occurs when connecting
as an externally authenticated user.

TOR-8335 Toolbars: The Window menu identifies the incorrect window as active in some
cases.

TOR-8336 SQL Recall: Statements dragged to the Editor are missing the statement
terminator.

TOR-8337 Login Window: The LDAP dropdown does not populate after unchecking
"Connect using Oracle client".

TOR-8338 Session Browser: The splitter position is incorrect when using the left/right
layout and switching to another window.

TOR-8382 Database Health Check: An error is shown when the "list segments which can't
extend" option is used and there are tablespaces which cannot extend.

TOR-8387 DBMS Output: Fetching output results in an ORA-02005 error with some
clients.

TOR-8390 link Editor: The EDIT command occasionally triggers an unexpected ORA-00904
error.

TOR-8396 link

Automation Designer: The Export Dataset action fails to replace substitution
variables if there are comments or trailing whitespace on lines preceding them.
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https://forums.toadworld.com/t/bad-pkg-proc-parameter-copy-paste-behavior/59512
https://forums.toadworld.com/t/apps-no-longer-work-with-version-17-1-parameters-are-out-of-sync-with-sql-text-in-export-dataset/59528
https://forums.toadworld.com/t/display-full-path-as-tab-hints-sometimes-stops-working/59497
https://forums.toadworld.com/t/dbms-output-text-display-corruption-on-long-lines/59501
https://forums.toadworld.com/t/edit-command-error/59703
https://forums.toadworld.com/t/export-dataset-to-excel-file-with-multiple-tabs/59699

Issue ID Link to Resolved Issue
Forum Post

TOR-8414 Editor: In some cases Toad hangs when selecting text when the Brace
Highlighting option is set to 'Innermost pair in scope'

TOR-8417 Team Coding: Files with special characters in their filenames are not displayed
in the Team Coding Manager's list of VCS files.

TOR-8437 link macOS: Toad on macOS will not start with some locale settings, e.g. Korean.

TOR-8445 link Data Grid: Object Editor shows incorrect columns and throws an Access
Violation after scrolling in some cases.

TOR-8463 SFTP: Connecting with a private key that was created with a passphrase
results in a "Logon failed 280: Error decoding key: The specified password is
not correct" error.

TOR-8477 Compare Data: A "Cannot insert null" error is thrown in some cases.

TOR-8478 Schema Browser: An error occurs when expanding Unified Audit Policies in
treeview mode.

TOR-8496 Report Editor: Buttons on the vertical toolbar in the FastReport Editor will
disappear after mousing over them on Windows Server.

TOR-8497 Editor: Selecting text and replacing all occurrences of it using the Find &
Replace dialog with the "from cursor" option excludes the selected text.

TOR-8499 link Export DDL: Table scripts are incorrect with respect to automatic and interval
partitions when the "Storage Objects | Partitions" option is set to ALL or
DEFAULT/MAXVALUE.

TOR-8521 link

Data Grids: The'..." button to choose a filename is disabled in the Export
Dataset dialog when the Output selection is changed from Clipboard to File.

Toad for Oracle 17.1

The following list of resolved issues includes issues received from the Toad for Oracle forum, Toad Beta users, and
exception data collected from the Toad Improvement Program.

Issue ID Link to Resolved Issue
Forum Post
TOR-6106 link Connections: Timezone data is incorrect when querying some databases
using "no client" mode.
TOR-7625 link Color Schemes: Some buttons on the login window lack a border when using
color schemes on Windows Server 2016.
TOR-7709 link Toolbars: The window menu, shown to the left of the File menu for maximized

windows, duplicates its menu items each time it is clicked.
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https://questsoftware.my.salesforce.com/aQ6RP0000000Y4v0AE
https://forums.toadworld.com/t/unexpected-behavior-of-object-edit-24-2-167-4299/59783
https://forums.toadworld.com/t/toad-not-generating-ddl-for-automatic-partitions/59880
https://forums.toadworld.com/t/export-dataset-excel-file-unable-to-select-new-location/59848
https://forums.toadworld.com/t/on-monday-you-can-do-this/54914
https://forums.toadworld.com/t/toad-beta-17-0-310-appearance-of-the-buttons-new-connection/58310
https://forums.toadworld.com/t/window-icon-menu-becomes-larger-on-each-click/58534

Issue ID Link to Resolved Issue
Forum Post

TOR-7768 link Connections: The connection bar "Containers" menu is out of sync after an
ALTER SESSION SET CONTAINER statement is executed in the Editor.

TOR-7824 link Script Execution: The elapsed time shown in the progress dialog is incorrect in
some cases.

TOR-7839 Execution: Access Violation occurs when using "no client" mode and selecting
RAW datatype over a database link.

TOR-7868 link Connection Bar: The "Reconnect all" menu item is disabled at times it should
be enabled.

TOR-7874 link Editor: Compiling a package having an error indicates the wrong line as having
the error.

TOR-7880 link Export Dataset: The default extension for Excel should be .xIsx and for Access
it should be .accdb.

TOR-7882 link Mac: Editor takes a long time to load if CAPS lock is enabled.

TOR-7888 link Editor: Goto Line (Ctrl+G) throws an exception in some cases.

TOR-7906 Data Grids: ORA-00903 error is raised when updating data of a LONG RAW
field.

TOR-7909 link Schema Browser: Tab key does not advance through all fields properly in the
Filter/Sort dialog.

TOR-7912 Debugger: Access Violation occurs in some cases if the background session is
disconnected.

TOR-7955 link Connection Bar: Opening a window from the "Frequently used" menu of an
inactive session's connection bar button opens the window for the active
session, instead.

TOR-7963 Export Dataset: Exporting to Excel does not include data for CLOB fields
exceeding 32767 characters.

TOR-7969 link Workspaces: Access Violation occurs when loading a workspace in some
cases.

TOR-7971 link Automation Designer: The Compare Schemas action uses CREATE instead of
CREATE OR REPLACE in the sync script when executed using a parameter
file that was created with Toad for Oracle 16.3 or older.

TOR-7982 Code Analysis: Running Code Analysis with the SQL Scan option enabled
causes Toad to disappear in some environments.

TOR-7988 link

Schema Browser: The Alter Table dialog includes the schema in ALTER
TABLE RENAME COLUMN statements when the "Show SQL without
schema" menu item is chosen.
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https://forums.toadworld.com/t/toad-17-how-containers-list-updated/58650
https://forums.toadworld.com/t/17-1-451-execution-time-string-glitch-in-processing-script-window/58701
https://forums.toadworld.com/t/reconnect-all-lost-connections/58792
https://forums.toadworld.com/t/17-1-478-the-wrong-line-is-highlighted-if-a-compilation-error-occurs/58805
https://forums.toadworld.com/t/17-x-export-dataset-to-excel-file-chooses-xls-extension-if-none-specified/58813
https://www.codeweavers.com/support/bugs/browse?cmd=bug_edit;bug_id=23249;
https://forums.toadworld.com/t/bug-report-control-g/58846
https://forums.toadworld.com/t/tab-sequence-filter-dialog/58859
https://forums.toadworld.com/t/bug-on-the-connection-toolbar-open-new-editor-on-active-session-and-not-on-the-session-selected-by-pointer/58928
https://forums.toadworld.com/t/access-violation/58814
https://forums.toadworld.com/t/toad-compare-version-17/58977
https://forums.toadworld.com/t/17-1-564-sql-contains-schema-name-when-renaming-a-column-in-alter-table-window/59023

Issue ID Link to Resolved Issue
Forum Post

TOR-7989 link Toolbars/Menus: Setting a custom shortcut for Print Preview does not work.

TOR-7996 link Workspaces: Creating a new Editor tab after opening a workspace does not
always activate the new tab.

TOR-7997 link Editor: The Load DB Object window has an empty, gray panel when the "Show
source" checkbox is unchecked.

TOR-8002 Connections: The Reconnect button is unavailable on the dialog shown for
ORA-00045 errors.

TOR-8006 Automation Designer: The Format Files action modifies reserved word
character case and does not format the code

TOR-8007 link Automation Designer: Variable substitutions are not made to the Export
Dataset action's SQL text if the SQL has been modified after mapping
substitution variables to Automation Designer variables.

TOR-8012 link Session Browser: Quickly clicking on nodes in the left side navigator causes
the Session Browser to process each click and slow down for a bit as it catches
up.

TOR-8040 General: Long error message text is truncated in error dialogs if using a dark
color scheme.

TOR-8044 Schema Browser: The Tables Script tab truncates constraint text longer than
4000 characters.

TOR-8047 link Master-Detail Browser: An error occurs when setting a filter having a comment
on the first line.

TOR-8056 Schema Browser: Filters set on the Invalid Objects tab do not affect indexes.

TOR-8063 Connections: Connecting to an Oracle Cloud database without a client raises
an ORA-12506 in some cases.

TOR-8081 link Statspack Browser: Copying a SQL Summary row to clipboard causes Toad to
freeze for a while..

TOR-8083 link Data Import Wizard: Custom date format does not accept dot or dash as date
separator.

TOR-8086 link Script Execution: DESC PACKAGE excludes functions and procedures
without parameters.

TOR-8093 link Data Grids: Saving a blob to file omits the extension if it is not specified in the
filename.

TOR-8096 link Data Grids: CTRL+F to find data selects wrong columns.

TOR-8103

Project Manager: Files loaded in external application always use the default
association from Windows instead of the association defined in the Project
Manager settings.
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https://forums.toadworld.com/t/shortcut-key-problems-in-editor/59020
https://forums.toadworld.com/t/blank-editor-tab-lost-focus/58993
https://forums.toadworld.com/t/editor-load-database-objects/58970
https://forums.toadworld.com/t/export-report-to-different-group-of-people/58899
https://forums.toadworld.com/t/session-browser-auto-refresh-issue/59086
https://forums.toadworld.com/t/master-detail-browser-filtering-features-buggy/59167
https://forums.toadworld.com/t/sql-summary-at-snapshot-freeze-with-control-c/59218
https://forums.toadworld.com/t/import-from-csv/59222
https://forums.toadworld.com/t/desc-bug-in-toad-17-0-353/59215
https://forums.toadworld.com/t/little-issue-when-exporting-blob-fields/59230
https://forums.toadworld.com/t/ctrl-f5-in-db-grid-strange-behavior-was-not-in-previous-versions/59228

Issue ID Link to Resolved Issue

Forum Post

TOR-8116 link Login Window: Connection made to the wrong database after editing a
previously used connection's alias in the grid and selecting a different
database from the right side dropdown and clicking Connect.

TOR-8117 link Data Grids: Record Count does not respect filtered records.

TOR-8172 link Automation Designer: Changing the output file extension of an Export Dataset
action using Excel file format from .xIsx to .xls will change the extensions of
other Export Dataset actions also exporting to Excel file format.

TOR-8178 Automation Designer: Format Files action introduces a mix of CRLF and LF

end of line characters.

Toad for Oracle 17.0 Patch 1

The following list of resolved issues includes issues received from the Toad for Oracle forum, Toad Beta users, and
exception data collected from the Toad Improvement Program.

Issue ID Link to Resolved Issue
Forum Post
TOR-7680 Script Manager: Access Violation occurs when running scripts in 64-bit Toad.
TOR-7681 link Toad for Oracle on Mac: Animation on the Script Execution dialog looks bad.
TOR-7682 Toad for Oracle on Mac: "Task Manager not running" error on startup.
TOR-7683 Toad for Oracle on Mac: Compiling a Team Coding controlled object in the
Editor using shortcut (F9) results in endless loop.
TOR-7684 link Toad for Oracle on Mac: Cannot drag/drop files from Finder to Editor.
TOR-7686 Alter Database Link: Incorrect username for connection is shown.
TOR-7687 Editor Options: The Tab stop setting is not being saved when Toad closes.
TOR-7694 link Editor: The Navigator tree scrolls each time it refreshes.
TOR-7704 link Toad for Oracle on Mac: Find Next (F3) does not work properly if the find
dialog is not showing.
TOR-7705 link Toad for Oracle on Mac: Grid lines are invisible in some windows.
TOR-7711 Schema Browser: "Invalid table name" error is raised when generating scripts

for Tables, Views, and Materialized Views for users lacking the SELECT ANY
DICTIONARY privilege.

TOR-7712 Import Table Data: Importing from a Fixed Field Width file raises an incorrect
error regarding field size and nothing is imported.
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https://forums.toadworld.com/t/apparent-focus-bug-in-login-window/59285
https://forums.toadworld.com/t/filter-user-role-grants-not-satisfactory/59283
https://forums.toadworld.com/t/file-extension-in-toad-automation-designer/59314
https://forums.toadworld.com/t/toad-for-oracle-for-mac-processing-script-animation/58468
https://forums.toadworld.com/t/mctoad-drag-file-from-finder-into-editor/58476
https://forums.toadworld.com/t/what-is-causing-the-editor-to-rescan-something-when-i-type/58496
https://forums.toadworld.com/t/toad-for-oracle-for-mac-f3-doesnt-work-when-find-window-is-closed/58516
https://forums.toadworld.com/t/toad-for-oracle-for-mac-ui-differences/58507

Issue ID Link to Resolved Issue
Forum Post

TOR-7715 Automation Designer: Upgrading from Toad for Oracle 16.3 to 17.0 raises an
error at startup for ToadActions.dat if the 16.3 datafile contains a Data Pump
Import action.

TOR-7717 Debugger: "Invalid Oracle Home" error is raised when debugging if the session
is made without a client and no clients are installed.

TOR-7718 link Toad for Oracle on Mac: Cannot save BLOB data from the data grid BLOB
editor.

TOR-7737 Toad for Oracle on Mac: Poor font quality.

TOR-7753 Login Window: LDAP dropdown list is slow to load when in clientless mode.

TOR-7763 Toad for Oracle on Mac: CAPS lock can get out of sync.

TOR-7764 Toad for Oracle on Mac: The TNS_ADMIN location is not as apparent as it
could be.

TOR-7838

TNSNAMES Editor: Adding a new service is nonfunctional.

Toad for Oracle 17.0

The following list of resolved issues includes issues received from the Toad for Oracle forum, Toad Beta users, and
exception data collected from the Toad Improvement Program.

Issue ID Link to Resolved Issue
Forum Post

TOR-2632 Editor: "Refactor > Remove Subqueries" generates invalid SQL when
aggregate functions are present

TOR-6414 link Data Grids: Strings exceeding the width of the control do not show a trailing
ellipsis

TOR-7086 link Triggers: Incorrect DDL is generated for disabled triggers containing a header
comment and a WHEN clause

TOR-7087 link Login: When grouped by multiple columns, deleting records from an expanded
group collapses all other expanded groups

TOR-7089 link Session Browser: Locks tab does not select the top row following a refresh

TOR-7101 link Schema Browser: Favorites folder cannot be renamed

TOR-7102 link Schema Browser: Scheduler Job script is invalid when the job has unnamed
arguments

TOR-7103 link

Alter Tablespace: Maximum size is changed to UNLIMITED in some cases

Toad for Oracle 2024 R2
Release Notes


https://forums.toadworld.com/t/mctoad-blob-popup-editor-error/58549
https://forums.toadworld.com/t/data-grid-truncation-not-visible/55816
https://forums.toadworld.com/t/schema-compare-error-in-sync-script-for-disabled-trigger/57145
https://forums.toadworld.com/t/login-window-delete-entry/57121
https://forums.toadworld.com/t/small-enhancement-request-for-session-browser/57146
https://forums.toadworld.com/t/edit-folder-name-in-favorites-does-not-work-in-latest-beta/57154
https://forums.toadworld.com/t/spooling-out-dml-for-scheduler-job-that-runs-a-scheduler-program/57152
https://forums.toadworld.com/t/alter-tablespace-maximum-size-became-unlimited/57156

Issue ID Link to Resolved Issue
Forum Post

TOR-7112 link Generate Schema/Database Script: IN MEMORY and COMPRESSION
options are ignored

TOR-7117 Session Browser: Selected row in the Open Cursors tab changes after
activating a different tab and returning to Open Cursors

TOR-7130 Insert Table Data: Some rows are not imported following a constraint violation
when the "Use Array DML" option is checked

TOR-7133 link Workspaces: Unicode characters in the Editor are lost

TOR-7134 link Schema Browser: Scheduler Job run log throws an error on Oracle database
10g Release 1

TOR-7135 link Export Dataset: Auto detection of schema doesn't work with a SELECT from a
table across a database link containing a'." in its name

TOR-7176 link Schema Browser: Sending a trigger to the Editor ignores the Editor option to
exclude schema name when loading objects

TOR-7178 link Code Insight: Results not shown when invoked within SQL containing a
subquery.

TOR-7181 Subscription Licensing: An Access Violation occurs after upgrading Toad in
some cases

TOR-7185 link Schema Browser: Incorrect script is generated for tablespaces that are
encrypted, but not compressed

TOR-7195 link Schema Browser: Rebuild Table window does not allow new columns having a
name longer than 30 characters on Oracle database 12g Release 2 and newer

TOR-7201 Automation Designer: Execute Script action fails if the output file or path
contains variables

TOR-7202 Team Coding: The Team Coding Browser VCS tab hangs when using Azure
DevOps Services (TFVC)

TOR-7210 link Data Grids: Sorting a column no longer focuses the sort direction radio group
by default

TOR-7211 link Change Password: ORA-00922 is raised when changing password if a
password verify function has been configured

TOR-7217 Data Grids: The columns dropdown on the Filter tab of the Filter/Sort Data
dialog is not wide enough to show long column names

TOR-7232 link Editor: The prompt to reload files modified externally is shown even after
choosing "Yes to All" at the initial prompt and then deactivating and activating
Toad

TOR-7233 link

Team Coding: The compare dialog does not show Unicode characters
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https://forums.toadworld.com/t/i-want-to-no-inmemory-phrase-for-create-tablespace/57213
https://forums.toadworld.com/t/17-0-18-editor-used-wrong-encoding-when-saving/57393
https://forums.toadworld.com/t/schema-browser-scheduler-job-run-log-ora-904/57399
https://forums.toadworld.com/t/17-0-18-automatic-determination-of-schema-and-table-when-exporting-as-insert-statements-fails/57411
https://forums.toadworld.com/t/17-0-41-full-qualified-trigger-name-when-loading-from-the-schema-browser/57476
https://forums.toadworld.com/t/toad-16-3-codeinsight-stops-working-when-using-nested-query/57475
https://forums.toadworld.com/t/script-for-encrypted-tablespace-missing-encrypt-keyword/57517
https://forums.toadworld.com/t/latest-beta-imposes-odd-oracle-col-name-length-in-rebuild-table-wizard/57540
https://forums.toadworld.com/t/schema-brower-sort/57601
https://forums.toadworld.com/t/change-password-sql-needs-to-quote-new-password/56549
https://forums.toadworld.com/t/17-0-91-externally-modified-files/57651
https://forums.toadworld.com/t/general-encoding-in-toad-options/57609

Issue ID Link to Resolved Issue
Forum Post

TOR-7237 link Trace File Browser: The modified date of some files is not displayed

TOR-7240 link Trace File Browser: Poor contrast when using a dark color scheme

TOR-7257 Editor: Refactor | Resolve Package Constants does not work for SQL
containing a single package constant reference

TOR-7262 link Code Insight: Very slow filtering of results while typing in some cases

TOR-7264 link Code Analysis: SQL Scan does not work when using proxy user authentication

TOR-7266 link Data Grids: Popup Editor throws a "Cannot modify a read-only dataset" error
when formatting text

TOR-7274 link Data Grids: Using the DEL key to clear a cell throws an "Invalid value for field"
error when the column has a foreign key

TOR-7319 link TNSNames Editor: Some parameters within the SECURITY section are
unsupported

TOR-7332 Color Schemes: Schemes are not fully applied to SQL Recall after changing
the color scheme and restarting Toad

TOR-7347 Compare Schemas: Schema name is excluded in the sync script if the "Include
Schema in Migration DDL" and "Format before comparison" options are both
checked

TOR-7349 link Script Execution: The SQL feedback text is formatted poorly or incorrect with
some statements

TOR-7358 link Code Insight: PL/SQL objects are not shown in the list in some cases.

TOR-7376 link Explain Plan: Toad sometimes connects to the wrong RAC instance when the
"Separate session" for Explain Plan option is set

TOR-7408 link Automation Designer: Export Dataset action changes the file extension of the
results file in some cases

TOR-7409 link Color Schemes: The selected node in some tree views is difficult to see with
some color schemes

TOR-7410 link Schema Browser: The left side navigator does not update its selected node to
reflect the caret position after searching for text in the Script tab of a package

TOR-7423 Team Coding: Access Violation occurs after dropping materialized views

TOR-7424 link Schema Browser: The generated script for Materialized View is incorrect when
the "Add to refresh group" option is checked in the script generation options

TOR-7438

Editor: The automatic backup feature does not clean up stale files and
references which can lead to Access Violations and general performance
issues in time
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https://forums.toadworld.com/t/blank-modified-date-in-trace-file-browser-select-file-from-db-server/57672
https://forums.toadworld.com/t/contrast-highlights-with-dark-scheme-in-trace-file-browser/57694
https://prodcloudoutlook.sharepoint.com/teams/support/migrated/InfoManagement/toad_for_oracle_support/Lists/Discussion Board/Flat.aspx?RootFolder=%2Fteams%2Fsupport%2Fmigrated%2FInfoManagement%2Ftoad%5Ffor%5Foracle%5Fsupport%2FLists%2FDiscussion%20Board
https://forums.toadworld.com/t/17-0-113-916-sql-scan-in-the-code-analysis-tool-always-produces-zeros-for-all-four-categories-in-the-results/57719
https://forums.toadworld.com/t/code-beautifier-in-clob-view/56808
https://forums.toadworld.com/t/17-0-134-1036-data-grid-error-during-delete-of-cell-value/57799
https://forums.toadworld.com/t/trouble-with-tnsnames-editor/27699
https://forums.toadworld.com/t/altertable-and-createindex-in-tsr-output/57944
https://forums.toadworld.com/t/17-0-183-1216-code-assist-not-working-with-certain-code/57969
https://forums.toadworld.com/t/separate-session-for-explain-plan-toad-16-3-231-2085/57681
https://forums.toadworld.com/t/export-dataset-to-xlsx/55068
https://forums.toadworld.com/t/schema-browser-toad-beta-17-navigator-not-highlighting-the-current-code/58033
https://forums.toadworld.com/t/schema-browser-toad-beta-17-navigator-not-highlighting-the-current-code/58033
https://forums.toadworld.com/t/bug-when-exporting-mviews-with-remove-and-add-to-refresh-group-commit-goes-in-wrong-spot/58063

Issue ID Link to Resolved Issue
Forum Post

TOR-7479 Test Connections: An Access Violation can occur when closing the dialog
immediately after testing connections

TOR-7480 link Automation Designer: FTP action does not observe variables in filenames to
download

TOR-7593 Schema Browser: The right side/detail view when selecting a table is scaled
incorrectly in same cases when using high-definition resolutions

TOR-7596 Import Table Data: Access Violation occurs when importing from CSV files
having fields with more than 32k bytes of data

TOR-7600

DB Health Check: Bad results are generated for the "Foreign Keys with mix of
nullable and not nullable columns" option

You can find the most up-to-date list of resolved issues for this release in the Toad for Oracle Release Notes found
at: https://support.quest.com/toad-for-oracle/technical-documents.
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Known issues

The following is a list of issues, including those attributed to third-party products, known to exist in this release line at
the time of the current release.

General known issues

Known Issue Issue ID
Toad's help cannot be opened from an installation path that contains Unicode characters. 72966
If you check "Indexes" on the Scripts tab for snapshots, then the primary key for the snapshot will N/A

be included in the script, even though the CREATE MATERIALIZED VIEW statement implicitly
creates this primary key.

Toad currently does not differentiate between indexes created explicitly on the snapshot and
indexes created automatically when the snapshot is created.

Workaround: If you are running the generated script to recreate the snapshot, then you can simply
ignore the error that occurs when the script tries to recreate the primary key index for the
snapshot. If you do not normally create indexes on snapshots, then you can uncheck "Indexes"
when generating the snapshot script.

If you use 11g Oracle ODP.NET client or any other client that does not have the oci.dll inthe BIN ~ N/A
directory, Toad has the following problems:

1. Client shows as invalid
2. Client version is not detected

3. Asaresult of #2, columns of the following datatypes are not shown in the Schema
Browser table data: CLOB, BLOB, NCLOB, XMLTYPE, TIMESTAMP, INTERVAL,
BINARY_DOUBLE, and BINARY_FLOAT

Debugger N/A

If there is an exception during debugging on a 10Gr2 or greater database, REFCURSOR output
and DBMS output will not be available when debugging is completed. This is due to the target
session not being available.

Workaround: To see REFCURSOR output and DBMS output, execute the procedure without the
debugger.

Connections N/A

While Toad supports LDAP connectivity, some features of Toad depend on tnsnames.ora file to
operate correctly, such as Toad Script Runner (TSR).
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Known Issue Issue ID

Schema Browser N/A

Sometimes after pressing "Compile invalid objects", you may get ORA-20000, ORA-06512, or
ORA-06512 errors. This could mean that you do not have the privileges to compile the object, but
it also happens when the schema contains a package body that does not have an associated
spec.

Workaround: Look in the schema that you are trying to compile to see whether there are any
orphan package bodies. If it is your own schema, then do:select * from user_objects 01 where
object_type = "PACKAGE BODY" and not exists (select "x" from user_objects 02 where
02.object_name = o1.object_name and 02.object_type = "PACKAGE") Then drop any orphan
package bodies that are found.

Virtualization 76354
An access violation error may display when you close Toad in a Citrix XenApp environment.

Import/Export 59228
Constraint scripts from Export DDL do not contain the "using index" or "tablespace" clause.

Oracle client known issues

Known Issue Issue
ID
In some cases, connecting to an 11g database using a 19¢c or 21c¢ client may result in a hang when N/A

cancelling a query or when using Code Insight.
Workaround: Use an 18c or older client when connecting to an affected database.

All versions of Oracle client 19¢ leak memory when working with LOB types. This includes simple N/A
SELECT statements against a table containing LOB types.

Queries that return fields with a BOOLEAN datatype result in a 'Datatype is not supported' error when N/A
using the Oracle 23ai client.

Workaround: Use an older Oracle client or make the connection without using a client.

Proxy server known issues

Known Issue Issue ID

Toad does not support Proxy Automatic Configuration (PAC) scripts; however, Toad does allow 72966
you to specify Quest-specific proxy settings to work around this limitation. By default Toad will use
non-PAC proxy settings configured within Windows automatically.

Apply settings system-wide:

HKEY_LOCAL_MACHINE\Software\Quest Software\lnternet Settings:

Toad for Oracle 2024 R2
Release Notes



Known Issue Issue ID

« ProxyEnable (DWORD): 1 = enable proxy override at this level, 0 = don't enable proxy
override at this level

« ProxyServer (string): semicolon-delimited "<protocol>=<server>:<port>" entries
« Forashared proxy server across multiple protocols:
« asingle "<server>:<port>" entry is all that's needed (ex: "127.0.0.1:8888")
« Forindividual proxy servers by protocol, specify multiple entries:

o ex: "https=127.0.0.1:8888;http=127.0.0.1:8080;ftp=127.0.0.1:6300"
For 32-bit applications on a 64-bit machine:

o Key: HKEY_LOCAL_MACHINE\Software\WOWG6432Node\Quest Software\Internet
Settings:

Apply settings to your own account:

HKEY_CURRENT_USER\Software\Quest Software\lnternet Settings:

« Same keys as above
Notes for use:

1. Override proxy settings will only be included if the corresponding ProxyEnable value is set
to"1". Otherwise, it's ignored.

2. HKLM (system-wide) server settings will override Windows settings.
3. HKCU (local) server settings will override HKLM and Windows settings.

4. Users can also edit both the system proxy settings (existing in Toad 14.0) and now their
user-specific proxy settings (from HKCU) within Toad's Proxy Settings dialog (View |
Options | Online); however, system-wide settings (from HKLM) will not be editable inside
of Toad since they're more for administrators in silent installs or system-wide configs.

Data Grids known issues

Known Issue Issue
ID

You may receive an "ORA-00902 invalid datatype" error when editing an object, nested table, or varray N/A
data if you have redefined the data type for that data during the current session.

Workaround: If you redefine an object type, nested table, or varray and then need to edit data in a table
based on that type, end your current connection and begin a new one.

Full table data is not displaying in the live data grid (results from F9) if the data contains "zero"
characers (ACII 0). In this case, all data after the zero character will not show in the grid.

Workaround: Double click on the data cell in the data grid to view full contents of data in a popup editor.
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Code Analysis known issues

Known Issue Issue ID
Saving results to a database: When dealing with nested procedures, Code Analysis can only N/A
insert run data from procs one level deep.

Saving PL/SQL results to a database may fail or save invalid data to the database for invalid N/A
PL/SQL objects.

Workaround: To ensure PL/SQL results are saved to the database correctly, verify the validity of
all objects before running Code Analysis.

Editor known issues

Known Issue Issue ID

Toad errors when you query on a field of Oracle collection types. 64373
Workaround: Execute using SQL*Plus.

When spooling to an unpinned output window, the window becomes unresponsive and errors are 68523
given when Toad is closed ("Canvas does not allow drawing").

Workaround: Keep the output window pinned.

If you use a non fixed-width font, the results are misaligned in the of Script Output tab in Editor 62234
after executing a SQL script.

Workaround: Go to Options | Scripts and select a fixed-width font for script output.

Session Browser known issues

Known Issue Issue ID

The Program name in the Session Browser may be blank or may be the full path to the executable N/A
instead of just the executable name. This depends on the Oracle client, not on Toad.

In RAC databases, version 10.1.0.3 (and possibly other 10.1 versions), the query used to N/A
populate the "Current Statement" in the Session Browser fails with the following error: Runtime

error occurred: 12801 (ORA-12801: error signaled in parallel query server PZ99, instance

<instance name> ORA-01008: not all variables bound) This problem does not occur in Non-RAC
environments.

Workaround: Clear the "Use RAC Views" checkbox, and log into the appropriate instance of the
database, if necessary.
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Team Coding known issues

Known Issue Issue ID
Creating a new revision or attempting to force a check-in to Visual Studio Team Services may N/A
result in a "404: Not Found" error. The current version of Team Foundation Server used by Visual
Studio Team Services compares the source being uploaded with the source already in the
repository. If the source has not changed, it may incorrectly return an error rather than allowing
the forced revision. This appears to be a Microsoft issue. As a result, these two commands may
fail.
When using the Team Foundation Server internal client and Team Foundation Server 2012 or 114334
2013 alternate Team Project Collections, workspaces created outside of Toad are not visible from
within Toad. A workspace may be created from Toad by clicking the ‘New’ button during the
Team Foundation Server log in.
This is not an issue when using the Team Foundation Server external client.
Team Coding is disabled for mixed-case object names. N/A
With CV'S, Toad may fail to retrieve the list of projects for you to select from in the CVS browseror  N/A
in the Code Control Groups configuration.
Workaround: See "Missing CVS\Entries File Error" in the online help.
Team Coding and Clearcase: Dynamic Views are not supported via SCC interface. Snapshot N/A
Views must be used instead. (Rational case ID v0830629, Rational Defect # CMBU00053934)
Unicode known issues
Known Issue Issue ID
The following features in Toad do not support Unicode: N/A
o ASM Manager
» Export File Browser
« Hex Editor
In addition, Java itself does not allow Unicode class names or file names. This is relevant to the
Java Manager, Editor, and Schema Browser.
Editor options to highlight object names may not work for object names that contain Unicode N/A
characters.
Script Execution in Editor: Error offset can be incorrect when running scripts with multi-byte object N/A
names.
XML (Plain) format creates bad XML if Unicode string values and Unicode column names are N/A
exported through Export Dataset.
63221

Import mapping for Unicode characters is incorrect if the characters are not a fixed width (such as
Korean).
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Known Issue Issue ID

In Team Coding, objects with Unicode contents are supported, objects with Unicode names are N/A
not. Supported Version Control Providers do not support Unicode names.

The OCl option ORA_NCHAR_LITERAL_REPLACE affects the NCHAR String Literal N/A
Replacement behavior when connected to non-Unicode databases. The option can be enabled or
disabled. See the "Enable ORA_NCHAR_LITERAL_REPLACE" option (View | Options | Oracle |
General). The option has adverse behavior regardless of its value.

« Enabled - ORA-01756 error when executing SQL using the Q-quote operator where the
end delimiter appears within the string literal and is followed by a single quote that is also
part of the string literal. The single quote does not have to immediately follow the delimiter.

« Disabled - NCHAR string literal corruption when connected to non-Unicode database.

High DPI known issues

Known Issue Issue

Changing the default Editor font when Windows high DPI settings are in use, i.e. scaling greater than N/A
100%, may result in negative effects, including:

o Character misplacement
« Disproportionate spacing
o Text selection visualization not aligning with character boundaries

» Incorrect text edits when modifying text using a block selection

Advanced options for controlling Editor rendering have been introduced in Toad for Oracle 2024 R2 to
help alleviate these issues. See the Editor | Behavior page in Toad Options.

« Drawing technology
» Controls which drawing APl is used to render text and other elements.

» Default technology makes Toad susceptible to high DPI issues, but it may allow for
sharper text on 4k and other Ultra HD (UHD) displays.

» DirectWrite technology resolves high DPI issues and may allow for sharper text on
displays less than 4k, but on 4k/UHD displays text may appear fuzzy.

» DirectWrite technology must be used to enable font ligatures in supporting fonts, e.g.
Fira Code.

« Buffered draw

« Controls whether drawing is buffered by first drawing to a bitmap rather than directly to
the screen and then copying the bitmap to the screen.

» Buffered drawing avoids flickering but does take longer.

» Enabling this option is recommended.
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Known Issue Issue
ID
« Font quality
» Controls which anti-aliasing method is used to render text.
+ LCD Optimized is recommended based on internal tests on different displays.
If you see high DPI issues and wish to use the Default technology, there are a few workarounds:
o Choose a font that is not susceptible to the issues.
« The following table lists popular coding fonts and sizes. Combinations that work well are
identified by a check mark.
Size Cascadia Consolas  Courier Fira JetBrains Source
Code New Code Mono Code
Pro
5 v v v v v
6 v v v
7 v v
8 v v
9 v v v v
10 v v v v v
11 v v v v v v
12 v v
14 v
16 v
18 v v v
20 v v v v v
« Change the high DPI settings for Toad.exe from the Compatibility tab of the file’s properties
dialog to override the high DPI scaling behavior and set its value to Application.
« On some displays this setting causes some Ul elements to scale incorrectly and may
need to be reverted.
» Use 100% scaling in Windows.
Toolbars N/A

(Affects Windows Server 2019 only)

Toolbar button images may disappear when you mouse over them if the "High DPI scaling override"

option is set to "System (Enhanced)" in the Windows file properties dialog for Toad.exe.
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Toad for Oracle on Mac known issues

Known Issue Issue ID

The "Allow multiple copies of Toad to be loaded" option is nonfunctional. N/A

The option allows multiple copies of Toad to be opened on Windows, but does not work on

macOS. The option has been disabled.

Workaround: Review macOS documentation for instructions on how to open a new instance of an

app on Mac.

The "File | Fast Exit" feature is nonfunctional. N/A

The feature allows for quickly closing Toad without prompting to save work. It has been disabled.

The Quit menu item from Apple's Toad for Oracle menu is nonfunctional if an Editor is open. N/A

Editor is slow to open if CAPS lock is enabled. N/A

Workaround: Turn off CAPS lock before opening Editor.

Bold text and other Ul painting issues after installing Team Coding database objects. N/A

Workaround: Restart Toad.

TNSPING is unavailable in the Login window. It is available in Toad for Oracle on Windows. N/A
Third-party known issues

Known Issue Issue ID

Help N/A

(Affects the 64-bit version of Toad only)

If IEQ is installed, clicking a link in the Help file may crash Toad 64-bit, even if IE9 is not the default
browser.

Workaround: Users who have IE9 installed can open Help from outside of Toad.
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System requirements

This section contains the hardware, software, and privileges required to run Toad for Oracle, as well as the
database and virtual environments that Toad for Oracle supports.

Hardware requirements

Requirement

Details

Processor

Memory

Hard disk space

Operating system

1 GHz processor - Toad for Oracle 32/64 bit

Apple Silicon (M-series processors) - Toad for Oracle on Mac
1 GB RAM - Toad for Oracle 32 bit

2 GB RAM - Toad for Oracle 64 bit

2 GB RAM - Toad for Oracle on Mac

The memory required may vary based on the following:
Applications that are running on your system

Size and complexity of the database

Amount of database activity

Number of concurrent users accessing the database

600 MB - Toad for Oracle 32/64 bit
2 GB - Toad for Oracle on Mac

Windows 10
Windows 11

Windows Server 2016
Windows Server 2019
Windows Server 2022
macOS 11

macOS 12

macOS 13

macOS 14
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Database requirements

Requirement

Details

Database client

Database server

Cloud database service

An Oracle client is optional.

Connecting to a database without an Oracle client has the following
considerations:

Features requiring Oracle utilities will be unavailable including, but
not limited to: SQL*Plus, Data Pumps, Import/Export Utilities, SQL
Loader, TKProf, TNSPing, Wrap.

Oracle Net Services configuration files are required for some
connection methods, e.g. TNS requires tnsnames.ora and LDAP
requires both Idap.ora and sqlnet.ora. These files may be placed in
the folder specified by your TNS_ADMIN environment variable or in
the same folder as Toad.exe.

The following Oracle clients are supported:

Oracle Client or Instant Client 10.2.0.5

Oracle Client or Instant Client 11.2.0.1/11.2.0.3
Oracle Client or Instant Client 12c Release 1 and 2
Oracle Client or Instant Client 18c

Oracle Client or Instant Client 19¢

Oracle Client or Instant Client 21c¢

Oracle Client or Instant Client 23c/23ai

NOTE: You must use the 32-bit version of Toad with the 32-bit Oracle client,
and the 64-bit version of Toad with the 64-bit Oracle client.

Oracle versions:

10g Release 2

11g Release 1 and 2
12c Release 1 and 2
18c

19¢

21c

23c/23ai

IMPORTANT: It is recommended that your client version be of the same
release (or later) as your database server. This is an Oracle
recommendation to prevent performance issues.

Oracle Database as a Service on Amazon EC2 and Oracle Cloud
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Network

« Internet Protocol Version 6 (IPv6) is being adopted by the US Federal Government and industries around
the world. In its most basic format, the new protocol uses 128-bit addresses instead of 32-bit addresses,
which are used by the current IPv4 to route packets over the Internet. Toad for Oracle features, such as
FTP, access the Internet through third-party vendors that are IPv6 compliant, such as /nSoftware's
IP*Works. For access to Web sites by way of the Toad Online window, Toad simply invokes the user-defined
or default Web browser.

* Toad for Oracle Subscription editions require the user to sign in when using the product. This enables the
product to verify the user's identity and to check that they are entitled to use the subscription. To complete
this entitlement check internet access is required to connect to Quest Software's Licensing Servers.

« Toad for Oracle Subscription edition is bundled with Quest Auto Update, a service to periodically check for
and deliver product updates. Quest Auto Update requires internet access and must be able to reach the
cloud service at https://autoupdate.toadworld.com.

Additional requirements

Requirement Details

Additional Software « Microsoft Internet Explorer 6.0 or later (to view video from the Jump
list within Toad, and to view the product documentation in HTML
format).

» Microsoft Office 2016 and recent earlier releases are supported for
Word and Excel output.

o Adobe Acrobat Reader 7.0 or later (to view the product
documentation in PDF format).

o Microsoft .NET Framework 4.0 to support the Toad for Oracle
Editions Installer.

Virtualization support

Type Details

Application virtualization Citrix® XenApp

Desktop virtualization (VDI) vWorkspace™ 7.0 has been tested.
Server virtualization Oracle VM 3.1 has been tested.

VMware ESX Server 3.5, 4.0, and 5.5 have been tested.

NOTE: Toad may work in virtualization environments other than the ones listed.
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Windows Privileges

In order to install and run Toad, make a connection, and do basic operations, you must have the following privileges.

Operating System Requirements

Windows non-Server » Read access to the Oracle client folder

Windows Server » Read/write privileges on the Oracle Home directories that you use for
your connections

NOTE: Toad for Oracle Subscription edition is bundled with Quest Auto Update, a service to periodically check for
and deliver product updates. Installation requires administrator privileges on all supported operating systems.

NOTE: Other functionality in Toad may require additional privileges.
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Product licensing

Legacy Toad for Oracle with offline
license keys

To activate a trial

1.

2
3.
4
5

Go to the trial download web page: https://www.quest.com/products/toad-for-oracle/software-
downloads.aspx, accessed through the product page.

Select the Toad for Oracle Edition that you want to try.
Log in to your account or register.
Accept the license terms.

Download the trial file.

To activate a purchased commercial license

1.

Go to the Quest Support website: https://support.quest.com/

2. Type the name of the product that you want to activate in the Enter your product to find support field.
3. Select Download New Releases.
4. Download the installer file.

NOTES:

License keys compatible with Toad for Oracle 9.7 and earlier versions are no longer supported.
Only the newer 48-character license keys are supported.

If you have an older license type, the Editions installer points you to the license web page where you
can update it.

Toad supports cumulative licensing. You can add multiple licenses, including those for add-ons like
Sensitive Data Protection, to Toad. Toad will use the licenses providing the highest degree of features.

Toad for Oracle Subscription with
online licensing (including Editions)

Toad for Oracle Subscription requires you to sign in with your Quest.com account. Licenses are tied to your account
giving you the flexibility to use Toad from multiple computers without having to move your license.
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Sign in with existing Quest.com account
1. Enter your account email address and password when prompted
2. Ifyou already have a Toad for Oracle Subscription license, no further action is needed

3. Ifyou do not have a Toad for Oracle Subscription license, see Activating a new license below

Create a new Quest.com account
1. Select Sign up for a new account
Enter your account details and select Sign Up

A confirmation email is sent containing a verification code

A 0D

Enter the code from the email and select Verify
NOTES:

* It may take a few minutes for the verification email to arrive

* Check your spam/junk folders for the email sent from supportadmin@quest.com if you do
not receive it

* For additional assistance, please contact Quest support

Activating a new license
1. Toad for Oracle Subscription automatically provides a fully functioning, 30-day Trial license
2. Topurchase a new license, click Buy Now from Toad's title bar
3. After completing your transaction, restart Toad and your license is automatically detected
4

To manage licenses, select Account Settings beneath your account shown at the top-right of Toad
NOTE: You can view your licenses from within Toad by selecting Help | Licensing
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Getting started with Toad for Oracle

Toad for Oracle is distributed in the Toad for Oracle Editions at https://support.quest.com/download-product-select.

Upgrade and installation instructions

Please refer to the Toad for Oracle Installation Guide at https://support.quest.com/technical-documents for
installation and upgrade instructions.

Upgrades for Toad for Oracle can install side-by-side with any previous versions you have installed. You can run the
new and previous versions concurrently.

The first time you run the new version of Toad, the settings files from the previous version are automatically
imported. To start with a clean set of user files, go to Utilities | Copy User Settings, then select Create a clean
set of user files from the base installation.

NOTE: Toad supports importing settings only if the new version is within two releases of the previous
version. If your versions are more than two releases apart, you need to install an intermediate version to
successfully import the files.

User instructions

To get started with using Toad for Oracle, see the Guide to Using Toad at https://support.quest.com/technical-
documents. For detailed information about any Toad window or feature, see the online help, which can be accessed
from the Help menu.

Additional resources

Additional information is available from the Toad for Oracle Community on Toad World:

https://www.toadworld.com/products/toad-for-oracle
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Globalization

Global Operation Statement

This section contains information about installing and operating this product in non-English configurations, such as
those needed by customers outside of North America. This section does not replace the materials about supported
platforms and configurations found elsewhere in the product documentation.

This release was not enabled and tested for international operation. Only U.S. English configurations of this product
and U.S. English datasets are fully supported. Support for non-ASCII characters or non-English configurations may
work appropriately, but these configurations have not been tested and this release should be used with caution in
these environments.

This release has the following known capabilities or limitations: Toad 13.1 is a Unicode application. As such, it has
support for any Oracle Unicode character set, such as UTF8 or AL32UTF8. There are some features in Toad which
use or invoke Oracle Utilities or applications which are not themselves Unicode applications. Their functionality is
therefore limited to the character set of the client on which Toad is running, and NLS_LANG must be carefully set to
match the Windows character set

We have also observed issues with US7ASCII when used with non Latin characters.
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About us

We are more than just a name

We are on a quest to make your information technology work harder for you. That is why we build community-driven
software solutions that help you spend less time on IT administration and more time on business innovation. We
help you modernize your data center, get you to the cloud quicker and provide the expertise, security and
accessibility you need to grow your data-driven business. Combined with Quest’s invitation to the global community
to be a part of its innovation, and our firm commitment to ensuring customer satisfaction, we continue to deliver
solutions that have a real impact on our customers today and leave a legacy we are proud of. We are challenging
the status quo by transforming into a new software company. And as your partner, we work tirelessly to make sure
your information technology is designed for you and by you. This is our mission, and we are in this together.
Welcome to a new Quest. You are invited to Join the Innovation™.

Our brand, our vision. Together.

Our logo reflects our story: innovation, community and support. An important part of this story begins with the letter
Q. Itis a perfect circle, representing our commitment to technological precision and strength. The space in the Q
itself symbolizes our need to add the missing piece — you — to the community, to the new Quest.

Contacting Quest

For sales or other inquiries, visit www.quest.com/contact.

Technical support resources

Technical support is available to Quest customers with a valid maintenance contract and customers who have trial
versions. You can access the Quest Support Portal at https://support.quest.com.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. The Support Portal enables you to:

« Submit and manage a Service Request

+ View Knowledge Base articles

« Sign up for product notifications

« Download software and technical documentation
« View how-to-videos

« Engage in community discussions
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» Chat with support engineers online

» View services to assist you with your product
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© 2024 Quest Software Inc. ALL RIGHTS RESERVED.

This guide contains proprietary information protected by copyright. The software described in this guide is furnished under a
software license or nondisclosure agreement. This software may be used or copied only in accordance with the terms of the
applicable agreement. No part of this guide may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording for any purpose other than the purchaser’s personal use without the written
permission of Quest Software Inc.

The information in this document is provided in connection with Quest Software products. No license, express or implied, by
estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of Quest Software
products. EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR
THIS PRODUCT, QUEST SOFTWARE ASSUMES NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED
OR STATUTORY WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
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